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ΔΙ΢ΑΓΩΓΗ 
 

 

Ιζηνξηθά νη κεηαιιηθέο θαηαζθεπέο από ράιπβα είλαη γλσζηέο από ηνλ 18
ν
 αηώλα. Όια 

ηα ζύγρξνλα θηίξηα αλά ηνλ θόζκν εκπεξηέρνπλ κεηαιιηθνύο θνξείο από ράιπβα. Όκσο 

ην ζπγθεθξηκέλν είδνο θαηαζθεπήο αλαπηύρζεθε ζηε ρώξα καο ηελ ηειεπηαία δεθαεηία 

θπξίσο ιόγσ έιιεηςεο ηεο θαηάιιειεο ηερλνγλσζίαο από ηνπο κεραληθνύο, ηεο 

απαηηνύκελεο εμεηδίθεπζεο ησλ ηερληηώλ θαη ζπλεπώο ην κεγαιύηεξν θόζηνο πνπ 

έρνπλ. 

Πέξα από ηελ αηζζεηηθή ηέηνησλ θαηαζθεπώλ ζην πξαθηηθό κέξνο κηα ραιύβδηλε 

θαηαζθεπή πξνζθέξεη αληνρέο πνιύ κεγαιύηεξεο από απηέο ηνπ κπεηόλ. Σν κέηαιιν 

δίλεη ηε δπλαηόηεηα ζηα θηίξηα λα έρνπλ πνιύ κεγαιύηεξε ειαζηηθόηεηα θάηη πνπ 

ζεσξείηαη πνιύ κεγάιν πιενλέθηεκα θαζώο ν θίλδπλνο θαηάξξεπζεο ελόο θνξέα 

θηηξίνπ κεηά από ζεηζκό πεξηνξίδεηαη ζε ζεκαληηθό βαζκό. Γηα ηε ρώξα καο ινηπόλ νη 

πςειέο θηηξηαθέο αληνρέο είλαη κείδνλνο ζεκαζίαο εάλ αλαινγηζηεί θαλείο όηη είκαζηε 

κηα πεξηνρή κε πνιύ έληνλε ζεηζκηθή δξαζηεξηόηεηα. Δπηπιένλ ν ρξόλνο θαηαζθεπήο 

θαη αλέγεξζεο κηαο κεηαιιηθήο θαηαζθεπήο είλαη ζπλήζσο πνιύ ιηγόηεξνο από εθείλν 

πνπ απαηηείηαη γηα κηα θαηαζθεπή από νπιηζκέλν ζθπξόδεκα, γεγνλόο πνπ επηηξέπεη 

ηνλ θαιύηεξν ζρεδηαζκό θαη ηε γξεγνξόηεξε πινπνίεζε επελδύζεσλ. 

Όζνλ αθνξά ηελ παξνύζα εξγαζία, ζθνπόο απηήο είλαη ε παξνπζίαζε κηαο 

ειαζηνπιαζηηθήο αλάιπζεο κεηαιιηθώλ θνξέσλ κε θνριηώζεηο κε ρξήζε 

πεπεξαζκέλσλ ζηνηρείσλ θαη ζύγθξηζε ησλ απνηειεζκάησλ απηήο ζε ζρέζε κε 

αληίζηνηρν πξαγκαηηθό πείξακα πνπ έγηλε ζην Παλεπηζηήκην ηεο Ινξδαλίαο (J.U.S.T.) 

από ην ηκήκα ησλ Πνιηηηθώλ Μεραληθώλ ππό ηελ θαζνδήγεζε ηνπ θαζεγεηή M. K. 

Abdalla. Οη ιόγνη πνπ νδήγεζαλ ζε κηα ηέηνηα αλάιπζε είλαη δηόηη ζε κηα κεηαιιηθή 

θαηαζθεπή νη ζπλδέζεηο έρνπλ ηε δπλαηόηεηα κε γξακκηθήο απόθξηζεο, ε νπνία 

αθελόο δελ έρεη δηεξεπλεζεί πιήξσο θαη αθεηέξνπ επεξεάδεη ηελ όιε ζπκπεξηθνξά ηεο 

θαηαζθεπήο θαη ηδηαίηεξα ζε αθξαίεο ζπλζήθεο (δηαξξνή ή/θαη θαηάξξεπζε). 

΢ηελ εξγαζία απηή ην πξόβιεκα επηιύζεθε κε ηξεηο δηαθνξεηηθέο παξαδνρέο γηα ην 

πιηθό καο. Πην ζπγθεθξηκέλα, ε πξώηε εθδνρή ζεσξεί ην πιηθό ειαζηνπιαζηηθό κε 

κηθξέο κεηαθηλήζεηο (όρη γεσκεηξηθή κε-γξακκηθόηεηα), ε δεύηεξε εθδνρή ζεσξεί πάιη 

ην πιηθό ειαζηνπιαζηηθό αιιά κε κεγάιεο κεηαθηλήζεηο (γεσκεηξηθή κε- 

γξακκηθόηεηα) ελώ ε ηξίηε εθδνρή ιακβάλεη ππόςε όηη ην πιηθό είλαη κόλν ειαζηηθό 

ρσξίο πιαζηηθέο παξακνξθώζεηο. ΢ε όιεο ηηο παξαπάλσ εθδνρέο αζθήζεθε θνξηίν κε 

δηαδνρηθή αύμεζε έσο έλα επηιεγκέλν αλώηαην επίπεδν θαη ηα απνηειέζκαηα απηήο ηεο 

αλάιπζεο παξνπζηάδνληαη ζε κνξθή γξαθεκάησλ κεηά ην πέξαο θαη ησλ ηξηώλ 

εθδνρώλ. Χξήζηκα ζπκπεξάζκαηα εμήιζαλ από απηή ηελ αλάιπζε, ηα νπνία θαη 

αλαιύνληαη ζην ηέινο ηεο εξγαζίαο απηήο.  
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ΚΔΦΑΛΑΙΟ 1 
 

 

ΓΗΜΙΟΤΡΓΙΑ ΓΙΑΣΑΞΗ΢ ΜΔ ΥΡΗ΢Η ΣΟΤ ΠΡΟΓΡΑΜΜΑΣΟ΢ 

Wildfire Pro-Engineer 2.0 
 

 

Γηα ηελ γεσκεηξηθή πξνζνκνίσζε ηνπ πεηξάκαηόο καο δεκηνπξγήζακε κέζσ ηνπ 

πξνγξάκκαηνο Pro-Engineer 2.0 ηε δηάηαμε πνπ καο ελδηαθέξεη κε ηελ παξαθάησ 

δηαζηαζηνιόγεζε όπσο δείρλνπλ νη παξαθάησ εηθόλεο. 

 

 

 

§ 1.1 Μησανολογικά ΢σέδια 
 

Γηα ηελ νξηδόληηα δνθό έρνπκε ηηο επόκελεο δύν εηθόλεο: 

 

 

 
Δικόνα 1: Όςε νξηδόληηαο δνθνύ 
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Δικόνα 2: Όςε νξηδόληηαο δνθνύ 

 

Γηα ηελ θάζεηε δνθό έρνπκε ηηο επόκελεο δύν εηθόλεο: 

 

 

 
Δικόνα 3: Όςε θάζεηεο δνθνύ 
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Δικόνα 4: Όςε θάζεηεο δνθνύ 

 

 

 

 

Γηα ηνπο θνριίεο έρνπκε ηηο επόκελεο δύν εηθόλεο: 

 

 
Δικόνα 5: Όςε θνριία 
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Δικόνα 6: Όςε θνριία 

 

 

 

 

Γηα ηελ δνθό ζπγθξάηεζεο έρνπκε ηηο επόκελεο δύν εηθόλεο: 

 

 
Δικόνα 7: Όςε δνθνύ ζπγθξάηεζεο 
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Δικόνα 8: Όςε δνθνύ ζπγθξάηεζεο 

 

 

 

§ 1.2 Σπιζδιάζηαηη Απεικόνιζη 
 

Έηζη ε δηάηαμε πήξε ηελ ηειηθή κνξθή όπσο θαίλεηαη ζηηο παξαθάησ εηθόλεο: 

 

 
Δικόνα 9:Οξηδόληηα δνθόο δηάηαμεο 
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Δ

Δικόνα 10:Κάζεηε δνθόο δηάηαμεο 

 

 

 

 

 
Δικόνα 11: Κνριίαο δηάηαμεο 
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Δικόνα 12: Γνθόο ζπγθξάηεζεο 

 

 

 

 

 
Δικόνα 13: ΢πλαξκνινγεκέλε δηάηαμε 
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Δικόνα 14: Κνληηλή πξνβνιή έλσζεο δνθώλ κε θνριίεο 

 

 

 

 

 
Δικόνα 15: Κνληηλή (πιεπξηθή) πξνβνιή έλσζεο δνθώλ κε θνριίεο θαη δνθνύ 

ζπγθξάηεζεο 
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ΚΔΦΑΛΑΙΟ 2 
 

ΜΟΝΣΔΛΟ ΠΔΠΔΡΑ΢ΜΔΝΩΝ ΢ΣΟΙΥΔΙΩΝ ΜΔ ΥΡΗ΢Η ΣΟΤ 

ΠΡΟΓΡΑΜΜΑΣΟ΢ ANSYS (Release 11.0) 
 

 

 

§ 2.1 Γενικά 
 

Όζνλ αθνξά ηε κνληεινπνίεζε, ε ελ ιόγσ θαηαζθεπή απνηειείηαη από δέθα θνκκάηηα 

(κία θάζεηε δνθό, κηα νξηδόληηα δνθό θαη νρηώ θνριίεο).Πάλσ ζε απηά ηα θνκκάηηα 

νξίδνπκε θάπνηεο παξακέηξνπο ηνπ πξνβιήκαηνο θαη θάλνπκε θαη θάπνηεο παξαδνρέο 

πνπ ζα καο νδεγήζνπλ ζηελ επίιπζε ηνπ πεηξάκαηόο καο. Όζνλ αθνξά ην κέγεζνο  ηνπ 

πξνβιήκαηνο, απηό απνηειείηαη από έλα αξθεηά κεγάιν αξηζκό εμηζώζεσλ γηα επίιπζε 

(~700.000 εμηζώζεηο) θαη κε αξθεηά κεγάιν ππνινγηζηηθό ρξόλν ηεο ηάμεσο ησλ 4-8 

σξώλ (ππνινγηζηηθό ζύζηεκα: AMD TURION 1,8 GHz , 32BIT , 2GB RAM). 

 

 

§ 2.2 ΢κοπόρ ηος πειπάμαηορ 
 

΢θνπόο ηνπ πεηξάκαηνο απηνύ είλαη λα ζπγθξίλνπκε ηα πξαγκαηηθά απνηειέζκαηα 

δύλακεο-παξακόξθσζεο πνπ έγηλε ζην παλεπηζηήκην Jordan University of Science and 

Technology (Irbid,Jordan) ζην ηκήκα ησλ Πνιηηηθώλ Μεραληθώλ(Department of Civil 

Engineering)  κε ηα απνηειέζκαηα πνπ βγάδεη έλα ινγηζκηθό ζηαηηθήο αλάιπζεο όπσο 

ην ANSYS. 

 

 

§ 2.3 Πεπεπαζμένα ΢ηοισεία SOLID187 
 

Σν ζηνηρείν απηό είλαη έλα πεπεξαζκέλν ζηνηρείν ηδαληθό γηα ην πείξακα απηό δηόηη 

είλαη ηξηζδηάζηαην θαη ρξεζηκεύεη ζε πνιύπινθεο δηαθξηηνπνηήζεηο (meshes) γηα 

αληηθείκελα όπσο απηά ησλ ζπζηεκάησλ CAD/CAM. Απνηειείηαη από 10 θόκβνπο κε 

3 βαζκνύο ειεπζεξίαο αλά θόκβν(κεηαηνπίζεηο ζηηο δηεπζύλζεηο ησλ θόκβσλ x,y,z). 

Δπίζεο έρεη ηε δπλαηόηεηα ειαζηνπιαζηηθήο ζπκπεξηθνξάο θαζώο θαη δπλαηόηεηα γηα 

κεγάιεο κεηαηνπίζεηο θαη παξακνξθώζεηο  

 

Δικόνα 16: Γεσκεηξία θαη ζύζηεκα ζπληεηαγκέλσλ ηνπ ζηνηρείνπ SOLID 187. 
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§ 2.4 Παπαδοσέρ Δπίλςζηρ 
 

Θεσξνύκε όηη ε νξηδόληηα δνθόο είλαη θνιιεκέλε(merged) κε ηελ θάζεηε θαη 

επηιύνπκε ηελ πεξίπησζε απηή ρσξίο λα έρνπκε ηε ζεώξεζε κνλόπιεπξεο επαθήο 

κεηαμύ ησλ θνκκαηηώλ αιιά κηα κόληκε επαθή. Έηζη ε δηάηαμε καο ιεηηνπξγεί ζαλ κηα 

εληαία νληόηεηα πνπ παξακνξθώλεηαη ζην ρώξν. Η επθνιία επίιπζεο κε κηα ηέηνηα 

παξαδνρή έγθεηηαη ζην γεγνλόο όηη ζηε δηάηαμε δελ εηζέξρνληαη θαη ζηνηρεία επαθήο 

(contact elements), θάηη πνπ αθελόο κεηώλεη ηνλ ππνινγηζηηθό ρξόλν ζηελ επίιπζε θαη 

αθεηέξνπ δελ απαηηεί από ην ρξήζηε εκπεηξία ζε ό,ηη αθνξά ηα ζηνηρεία επαθήο θαη ηηο 

παξακέηξνπο ηνπο. 

 

 

 

§ 2.5 Παπάμεηποι ππογπάμμαηορ ANSYS ππιν ηην επίλςζη 
 

 

§ 2.5.1 Δλαζηοπλαζηικό ςλικό με μεγάλερ μεηακινήζειρ (γευμεηπική μη-

γπαμμικόηηηα) 
 

Πην αλαιπηηθά ζέηνπκε ηηο παξαθάησ παξακέηξνπο ζην ANSYS πξηλ ηελ επίιπζε: 

 File → Import → Pro-E… → …diataksi.asm (αξρείν assembly ηνπ Pro-E) 

 Preferences → Structural θαη h-method 

 Preprocessor → Element type → Add/Edit/Delete → Add → SOLID 187 

 Preprocessor → Element type → Add DOF → Ux, Uy, Uz 

 Preprocessor → Material Props → Material Models → Structural →Linear → 

Elastic → Isotropic → EX=200000 θαη PRXY=0.3 

 Preprocessor → Material Props → Material Models → Structural → Nonlinear 

→ Inelastic → Rate Independent → Isotropic Hardening Plasticity → Mises 

plasticity → Bilinear → Yield Stss=314 θαη Tang Mod=10000 

 

Δδώ πξέπεη λα ηνλίζνπκε όηη ζέηνπκε δύν δηαθνξεηηθέο ηηκέο (TangMod=10.000 

θαη TangMod=5.000) ζηελ ηηκή ηεο εθαπηνκέλεο ηεο θακπύιεο γηα ηελ πιαζηηθή 

πεξηνρή. Με άιια ιόγηα επηιύνπκε ην πξόβιεκα δύν θνξέο έηζη ώζηε λα 

πξνζεγγίζνπκε θαιύηεξα ηα απνηειέζκαηα πνπ πήξακε από ην παλεπηζηήκην ηεο 

Ινξδαλίαο. 

 

 Preprocessor → Meshing → Size Cntrls → Smart size → Adv Opts  → OK 

 Preprocessor → Meshing → Mesh tool → Smart Size = 3 θαη Mesh Volume 1 

 Preprocessor → Meshing → Mesh tool → Smart Size = 2 θαη Mesh Volume 2 

 Preprocessor → Meshing → Mesh tool → Smart Size = 2 θαη Mesh Volume 3 

 Preprocessor → Meshing → Mesh tool → Smart Size = 2 θαη Mesh Volume 4 

 Preprocessor → Meshing → Mesh tool → Smart Size = 2 θαη Mesh Volume 5 

 Preprocessor → Meshing → Mesh tool → Smart Size = 2 θαη Mesh Volume 6 

 Preprocessor → Meshing → Mesh tool → Smart Size = 2 θαη Mesh Volume 7 

 Preprocessor → Meshing → Mesh tool → Smart Size = 2 θαη Mesh Volume 8 

 Preprocessor → Meshing → Mesh tool → Smart Size = 2 θαη Mesh Volume 9 

 Preprocessor → Meshing → Mesh tool → Smart Size = 2 θαη Mesh Volume 10 

 Preprocessor → Meshing → Mesh tool → Smart Size = 2 θαη Mesh Volume 11 

 Preprocessor →Numbering Ctrls → Merge Items → On nodes → OK 
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§ 2.5.2 Δλαζηοπλαζηικό ςλικό με μικπέρ μεηακινήζειρ (όσι γευμεηπική μη-

γπαμμικόηηηα) 
 

Πην αλαιπηηθά ζέηνπκε ηηο παξαθάησ παξακέηξνπο ζην ANSYS πξηλ ηελ επίιπζε: 

 File → Import → Pro-E… → …diataksi.asm (αξρείν assembly ηνπ Pro-E) 

 Preferences → Structural θαη h-method 

 Preprocessor → Element type → Add/Edit/Delete → Add → SOLID 187 

 Preprocessor → Element type → Add DOF → Ux, Uy, Uz 

 Preprocessor → Material Props → Material Models → Structural →Linear → 

Elastic → Isotropic → EX=200000 θαη PRXY=0.3 

 Preprocessor → Material Props → Material Models → Structural → Nonlinear 

→ Inelastic → Rate Independent → Isotropic Hardening Plasticity → Mises 

plasticity → Bilinear → Yield Stss=314 θαη Tang Mod=5000 

 Preprocessor → Meshing → Size Cntrls →Smart size → Adv Opts  → OK 

 Preprocessor → Meshing → Mesh tool → Smart Size = 3 θαη Mesh Volume 1 

 Preprocessor → Meshing → Mesh tool → Smart Size = 2 θαη Mesh Volume 2 

 Preprocessor → Meshing → Mesh tool → Smart Size = 2 θαη Mesh Volume 3 

 Preprocessor → Meshing → Mesh tool → Smart Size = 2 θαη Mesh Volume 4 

 Preprocessor → Meshing → Mesh tool → Smart Size = 2 θαη Mesh Volume 5 

 Preprocessor → Meshing → Mesh tool → Smart Size = 2 θαη Mesh Volume 6 

 Preprocessor → Meshing → Mesh tool → Smart Size = 2 θαη Mesh Volume 7 

 Preprocessor → Meshing → Mesh tool → Smart Size = 2 θαη Mesh Volume 8 

 Preprocessor → Meshing → Mesh tool → Smart Size = 2 θαη Mesh Volume 9 

 Preprocessor → Meshing → Mesh tool → Smart Size = 2 θαη Mesh Volume 10 

 Preprocessor → Meshing → Mesh tool → Smart Size = 2 θαη Mesh Volume 11 

 Preprocessor →Numbering Ctrls → Merge Items → On nodes → OK 

 

 

§ 2.5.3 Δλαζηικό ςλικό συπίρ πλαζηικέρ παπαμοπθώζειρ 

 

Πην αλαιπηηθά ζέηνπκε ηηο παξαθάησ παξακέηξνπο ζην ANSYS πξηλ ηελ επίιπζε: 

 File → Import → Pro-E… → …diataksi.asm (αξρείν assembly ηνπ Pro-E) 

 Preferences → Structural θαη h-method 

 Preprocessor → Element type → Add/Edit/Delete → Add → SOLID 187 

 Preprocessor → Element type → Add DOF → Ux, Uy, Uz 

 Preprocessor → Material Props → Material Models → Structural →Linear → 

Elastic → Isotropic → EX=200000 θαη PRXY=0.3 

 Preprocessor → Meshing → Size Cntrls → Smart size → Adv Opts  → OK 

 Preprocessor → Meshing → Mesh tool → Smart Size = 3 θαη Mesh Volume 1 

 Preprocessor → Meshing → Mesh tool → Smart Size = 2 θαη Mesh Volume 2 

 Preprocessor → Meshing → Mesh tool → Smart Size = 2 θαη Mesh Volume 3 

 Preprocessor → Meshing → Mesh tool → Smart Size = 2 θαη Mesh Volume 4 

 Preprocessor → Meshing → Mesh tool → Smart Size = 2 θαη Mesh Volume 5 

 Preprocessor → Meshing → Mesh tool → Smart Size = 2 θαη Mesh Volume 6 

 Preprocessor → Meshing → Mesh tool → Smart Size = 2 θαη Mesh Volume 7 

 Preprocessor → Meshing → Mesh tool → Smart Size = 2 θαη Mesh Volume 8 

 Preprocessor → Meshing → Mesh tool → Smart Size = 2 θαη Mesh Volume 9 

 Preprocessor → Meshing → Mesh tool → Smart Size = 2 θαη Mesh Volume 10 

 Preprocessor → Meshing → Mesh tool → Smart Size = 2 θαη Mesh Volume 11 

 Preprocessor →Numbering Ctrls → Merge Items → On nodes → OK 
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§ 2.6 Απεικόνιζη κομμαηιών μεηά ηη διακπιηοποίηζη με πεπεπαζμένα 

ζηοισεία (meshing) 
 

Παξαθάησ απεηθνλίδεηαη θάζε θνκκάηη κεηά ηελ δηαθξηηνπνίεζε κε πεπεξαζκέλα 

ζηνηρεία: 

 

 

 
Δικόνα 17: Απεηθόληζε ηεο θάζεηεο δνθνύ 
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Δικόνα 18: Απεηθόληζε ηεο θάζεηεο δνθνύ (θνληηλή) 

 

 

 

 
Δικόνα 19: Απεηθόληζε ηεο νξηδόληηαο δνθνύ 
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Δικόνα 20: Απεηθόληζε ηεο νξηδόληηαο δνθνύ (θνληηλή) 

 

 

 

 
Δικόνα 21: Απεηθόληζε ηνπ θνριία 
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Δικόνα 22: Απεηθόληζε ηεο δνθνύ ζπγθξάηεζεο 

 

 

§ 2.7 Οπιζμόρ ζημείυν μέηπηζηρ και θόπηιζηρ 
 

 

Σώξα καο ελδηαθέξεη λα νξίζνπκε ζε πνηα ζεκεία ζέινπκε λα κεηξήζνπκε ηε 

κεηαηόπηζε θαζ’ όιε ηε δηάξθεηα άζθεζεο ηεο θόξηηζεο. Θπκίδνπκε όηη ε θόξηηζε ζα 

αζθεζεί ζην άλσ ηκήκα ηεο νξηδόληηαο δνθνύ ζε απόζηαζε 1158 mm από ηελ αξρή ηεο 

δνθνύ (πάλσ δειαδή από ην ζεκείν 3) κε θαηεύζπλζε πξνο ηα θάησ(δειαδή θαηά –y). 

΢ύκθσλα κε ηα δεδνκέλα ηνπ πεηξάκαηνο ηα ζεκεία πνπ πξέπεη λα κεηξεζεί ε 

κεηαηόπηζε (θαηά –y) είλαη ηα εμήο: 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

Δικόνα 23: ΢εκεία κέηξεζεο ζηελ νξηδόληηα δνθό 

 

 

 

1158 mm 
660 mm 

330 mm 

΢εκείν 1 

 
΢εκείν 2 ΢εκείν 3 

 

 3 
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Γηα ην θάζε ζεκείν (Δηθόλα 23) βξίζθνπκε ζηελ δηάηαμε καο ζην ANSYS αληίζηνηρνπο 

θόκβνπο  (nodes) ζηνπο νπνίνπο ζα κεηξήζνπκε ηε κεηαηόπηζε ηνπο θάζε θνξά ζε 

ζρέζε πάληα κε ην αζθνύκελν θνξηίν. Δδώ πξέπεη λα αλαθέξνπκε όηη ιόγσ απμεκέλνπ 

αξηζκνύ θόκβσλ ζηα ζεκεία πνπ κεηξάκε, αξθεί λα πάξνπκε ζε θάζε ζεκείν έλα 

θόκβν θαη’ εθηίκεζε θαη λα δνύκε ηε ζπκπεξηθνξά ηνπ θαηά ηα ζηάδηα θόξηηζεο ηεο 

νξηδόληηαο δνθνύ. Δθόζνλ θαζνξίζακε ηα παξαπάλσ ζεκεία επηιέγνπκε ηνπο θόκβνπο 

ζύκθσλα κε ηελ δηαθξηηνπνίεζε (meshing) πνπ έρνπκε θάλεη. Απηό ζεκαίλεη όηη ζε 

θάζε άιιε πξνζπάζεηα δηαθξηηνπνίεζεο ηεο ίδηαο δηάηαμεο ν αξηζκόο ησλ επηιεγκέλσλ 

θόκβσλ ζα είλαη δηαθνξεηηθόο θαη απηό νθείιεηαη ζην όηη ην ινγηζκηθό δηαθξηηνπνηεί 

ηε δηάηαμή καο κε ηπραίν ηξόπν. 

 

Έηζη ζηε δηθή καο πεξίπησζε έρνπκε: 

 

΢εκείν 1 → Κόκβνο 140398  

΢εκείν 2 → Κόκβνο 140014 

΢εκείν 3 → Κόκβνο 140081 

 

Αθνύ δηαιέμακε ηνπο θόκβνπο απηνύο, εθαξκόδνπκε θνξηίν πξνο ηα θάησ(θαηεύζπλζε 

–y) ζην ζεκείν πνπ αλαθέξακε θαη πξνεγνύκελα ζε απόζηαζε 1158mm. Οη 

ζπληεηαγκέλεο απηνύ ζύκθσλα κε ηελ αξρή ησλ αμόλσλ ζην νιηθό ζύζηεκα 

ζπληεηαγκέλσλ(Global Cartesian coordinates) είλαη (x,y,z) = (305,1731,974.5).Γηα λα 

δηαιέμνπκε ηνλ θόκβν πνπ βξίζθεηαη ζην ζεκείν απηό επηιέγνπκε: 

 

 

 Preprocessor → Loads → Define Loads → Apply → Structural → 

Force/Moment → On Nodes 

΢ην παξάζπξν πνπ βγαίλεη νξίδνπκε ηνλ αξηζκό ηνπ θόκβνπ (node) όπσο απηό έρεη 

νξηζηεί από ην πξόγξακκα κεηά ηε δηαθξηηνπνίεζε. ΢ηε δηθή καο δηαθξηηνπνίεζε ν 

θόκβνο απηόο είλαη ν θόκβνο κε αξηζκό 158718. Παηάκε ΟΚ θαη έπεηηα νξίδνπκε ην 

θνξηίν ζε Νewton (όρη ζε kN). 

 

 

Σώξα ζα πξέπεη λα ζηαζεξνπνηήζνπκε ηηο βάζεηο ηεο θαηαζθεπήο καο. Απηό ζα γίλεη 

ζέηνληαο κεηαηόπηζε ίζε κε ην κεδέλ ζηηο πεξηνρέο πνπ βξίζθνληαη ζην θάησ κέξνο ηεο 

βάζεο ηεο θάζεηεο δνθνύ θαη ηεο βάζεο ηεο δνθνύ ζπγθξάηεζεο. Πην ζπγθεθξηκέλα: 

 

 

 Preprocessor → Loads → Define Loads → Apply → Structural → 

Displacement → On Areas  

 

 

΢ην παξάζπξν πνπ εκθαλίδεηαη νξίδνπκε ηηο πεξηνρέο Α15 θαη Α151 θαη ζέηνπκε 

κεδέλ ζε όινπο ηνπο βαζκνύο ειεπζεξίαο (All DOFs). 
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Δικόνα 24: Πεξηνρή Α15 (γηα ζηαζεξνπνίεζε βάζεο) 

 

 

 
Δικόνα 25: Πεξηνρή Α151 (γηα ζηαζεξνπνίεζε βάζεο δνθνύ ζπγθξάηεζεο) 
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§ 2.8 Οπιζμόρ παπαμέηπυν για ηην επίλςζη ζηο ANSYS και επίλςζη 
 

Σώξα νξίδνπκε θάπνηεο παξακέηξνπο πνπ αθνξνύλ ζηελ επίιπζε ηνπ πξνβιήκαηνο. 

Γηα ηελ αθξίβεηα νη παξάκεηξνη αλαθέξνληαη ζην ξπζκό κε ηνλ νπνίν ζα αζθεζεί ην 

θνξηίν ώζηε λα νδεγεζνύκε ζηε ζύγθιηζε θαη επνκέλσο ζηελ επίιπζε. Άξα: 

 

 Solution → Analysis type → Sol’n Controls  

 

 

§ 2.8.1 Δλαζηοπλαζηικό ςλικό με μεγάλερ μεηακινήζειρ (γευμεηπική μη-

γπαμμικόηηηα) 
 

΢ην παξάζπξν πνπ εκθαλίδεηαη ζηελ θαξηέια Basic νξίδνπκε ηα παξαθάησ: 

 

1. Analysis Options → Large Displacement Static 

2. α) Time Control → Time at the end of loadstep = 1.125 (γηα 

TangMod=10.000) 

β) Time Control → Time at the end of loadstep = 0.80 (γηα 

TangMod=5.000) 

3. Time Control → Automatic time stepping = Off  

4. Time Control → Time Step size = 0.05 

5. Write Items to Result file → All solution items 

6. Frequency → Write every substep 

 

 

Δπεμήγεζε επηινγήο ησλ παξαπάλσ παξακέηξσλ: 

  

Η επηινγή Large Displacement Static ρξεζηκνπνηείηαη όηαλ ζέινπκε ην πιηθό 

καο λα έρεη κεγάιεο κεηαθηλήζεηο (γεσκεηξηθή κε-γξακκηθόηεηα). 

Ο ρξόλνο ζην ηέινο ηεο θόξηηζεο ζα πξέπεη λα είλαη ζην 1,125 κε 

βήκα(substep) 0,05. Δπνκέλσο ζηελ πεξίπησζε καο όπνπ έρνπκε θόξηηζε 

112,5kN ην θνξηίν ζα αζθεζεί κε ξπζκό 0kN,5kN,10kN,…,112.5kN .Απηόο ν 

ξπζκόο νξίζηεθε από εκάο σο ν ηδαληθόηεξνο γηαηί καο βνεζάεη ζηελ 

δηακόξθσζε θαη ηελ γξαθηθή απεηθόληζε ησλ απνηειεζκάησλ καο. (Οκνίσο 

ζθεπηόκαζηε θαη γηα ηελ πεξίπησζε όπνπ έρνπκε θνξηίν 80 kN.) 

΢ην αξρείν RST (.rst file) πνπ θαηαγξάθνληαη όια ηα απνηειέζκαηα ηεο 

αλάιπζεο ζέινπκε λα γίλεη θαηαγξαθή όισλ ησλ απνηειεζκάησλ θη έηζη 

επηιέγνπκε Write Items to Result file → All solution items 

Απηά ηα απνηειέζκαηα ζέινπκε λα θαηαγξάθνληαη ζε όια ηα βήκαηα θόξηηζεο 

θαη έηζη ζηε ζπρλόηεηα θαηαγξαθήο (Frequency) επηιέγνπκε θαηαγξαθή ζε 

θάζε βήκα (Write every substep) 

 

Σηο ππόινηπεο παξακέηξνπο ζην παξάζπξν Sol’n Controls  ηηο αθήλνπκε όπσο είλαη 

νξηζκέλεο από ην πξόγξακκα ANSYS. 

 

 

 

Σέινο θαηαιήγνπκε ζηελ επίιπζε παηώληαο: 

 

 Solution → Solve → Current LS 
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§ 2.8.2 Δλαζηοπλαζηικό ςλικό με μικπέρ μεηακινήζειρ (όσι γευμεηπική μη-

γπαμμικόηηηα) 
 

΢ην παξάζπξν πνπ εκθαλίδεηαη ζηελ θαξηέια Basic νξίδνπκε ηα παξαθάησ: 

 

1. Analysis Options → Small Displacement Static 

2. Time Control → Time at the end of loadstep = 1.125 

3. Time Control → Automatic time stepping = Off  

4. Time Control → Time Step size = 0.05 

5. Write Items to Result file → All solution items 

6. Frequency → Write every substep 

 

 

Δπεμήγεζε επηινγήο ησλ παξαπάλσ παξακέηξσλ: 

  

Η επηινγή Small Displacement Static ρξεζηκνπνηείηαη όηαλ ζέινπκε ην πιηθό 

καο λα έρεη κηθξέο κεηαθηλήζεηο (όρη γεσκεηξηθή κε-γξακκηθόηεηα). 

Ο ρξόλνο ζην ηέινο ηεο θόξηηζεο ζα πξέπεη λα είλαη ζην 1,125 κε 

βήκα(substep) 0,05. Δπνκέλσο ζηελ πεξίπησζε καο όπνπ έρνπκε θόξηηζε 

112.5kN ην θνξηίν ζα αζθεζεί κε ξπζκό 0kN,5kN,10kN,…,112.5kN .Απηόο ν 

ξπζκόο νξίζηεθε από εκάο γηαηί καο βνεζάεη ζηελ δηακόξθσζε θαη ηελ γξαθηθή 

απεηθόληζε ησλ απνηειεζκάησλ καο. 

΢ην αξρείν RST (.rst file) πνπ θαηαγξάθνληαη όια ηα απνηειέζκαηα ηεο 

αλάιπζεο ζέινπκε λα γίλεη θαηαγξαθή όισλ ησλ απνηειεζκάησλ θη έηζη 

επηιέγνπκε Write Items to Result file → All solution items 

Απηά ηα απνηειέζκαηα ζέινπκε λα θαηαγξάθνληαη ζε όια ηα βήκαηα θόξηηζεο 

θαη έηζη ζηε ζπρλόηεηα θαηαγξαθήο (Frequency) επηιέγνπκε θαηαγξαθή ζε 

θάζε βήκα (Write every substep) 

 

Σηο ππόινηπεο παξακέηξνπο ζην παξάζπξν Sol’n Controls  ηηο αθήλνπκε όπσο είλαη 

νξηζκέλεο από ην πξόγξακκα ANSYS. 

 

 

 

Σέινο θαηαιήγνπκε ζηελ επίιπζε παηώληαο: 

 

 Solution → Solve → Current LS 

 

 

§ 2.8.3 Δλαζηικό ςλικό συπίρ πλαζηικέρ παπαμοπθώζειρ 
 

΢ην παξάζπξν πνπ εκθαλίδεηαη ζηελ θαξηέια Basic νξίδνπκε ηα παξαθάησ: 

 

1. Analysis Options → Large Displacement Static 

2. Time Control → Time at the end of loadstep = 1.125 

3. Time Control → Automatic time stepping = Off  

4. Time Control → Time Step size = 0.05 

5. Write Items to Result file → All solution items 

6. Frequency → Write every substep 

 

 

 



 

 

26 

Δπεμήγεζε επηινγήο ησλ παξαπάλσ παξακέηξσλ: 

  

Η επηινγή Large Displacement Static ρξεζηκνπνηείηαη όηαλ ζέινπκε ην πιηθό 

καο λα έρεη κεγάιεο κεηαθηλήζεηο (γεσκεηξηθή κε-γξακκηθόηεηα). 

Ο ρξόλνο ζην ηέινο ηεο θόξηηζεο ζα πξέπεη λα είλαη ζην 1,125 κε 

βήκα(substep) 0,05. Δπνκέλσο ζηελ πεξίπησζε καο όπνπ έρνπκε θόξηηζε 

112,5kN ην θνξηίν ζα αζθεζεί κε ξπζκό 0kN,5kN,10kN,…,112.5kN .Απηόο ν 

ξπζκόο νξίζηεθε από εκάο γηαηί καο βνεζάεη ζηελ δηακόξθσζε θαη ηελ γξαθηθή 

απεηθόληζε ησλ απνηειεζκάησλ καο. 

΢ην αξρείν RST (.rst file) πνπ θαηαγξάθνληαη όια ηα απνηειέζκαηα ηεο 

αλάιπζεο ζέινπκε λα γίλεη θαηαγξαθή όισλ ησλ απνηειεζκάησλ θη έηζη 

επηιέγνπκε Write Items to Result file → All solution items 

Απηά ηα απνηειέζκαηα ζέινπκε λα θαηαγξάθνληαη ζε όια ηα βήκαηα θόξηηζεο 

θαη έηζη ζηε ζπρλόηεηα θαηαγξαθήο (Frequency) επηιέγνπκε θαηαγξαθή ζε 

θάζε βήκα (Write every substep) 

 

Σηο ππόινηπεο παξακέηξνπο ζην παξάζπξν Sol’n Controls  ηηο αθήλνπκε όπσο είλαη 

νξηζκέλεο από ην πξόγξακκα ANSYS. 

 

 

 

Σέινο θαηαιήγνπκε ζηελ επίιπζε παηώληαο: 

 

 Solution → Solve → Current LS 
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ΚΔΦΑΛΑΙΟ 3 

 

ΑΠΟΣΔΛΔ΢ΜΑΣΑ ΑΝΑΛΤ΢Η΢ ΑΠΟ ΣΟ ΛΟΓΙ΢ΜΙΚΟ ANSYS 
 

 

 

§ 3.1 Πίνακερ αποηελεζμάηυν  
 

 

§ 3.1.1 Δλαζηοπλαζηικό ςλικό με μεγάλερ μεηακινήζειρ (γευμεηπική μη-

γπαμμικόηηηα) 

 

΢ύκθσλα κε ην απνηειέζκαηα ηνπ πεηξάκαηνο πνπ έγηλε ζην ANSYS βγήθαλ ηα 

αληίζηνηρα απνηειέζκαηα (TangMod=10.000): 

 

Βήκα 
Φνξηίν(ζε 

kN) 

Ρνπή 

Κάκςεο 

(kN.m) 

Μεηαηόπηζε (θαηά άμνλα -

y) Πεξηζηξνθή Μέζε ηηκή 

Πεξηζηξνθήο ΢εκείν 

1 

΢εκείν 

2 

΢εκείν 

3 

΢εκείν 

1 

΢εκείν 

2 

΢εκείν 

3 

0 0 0 0 0 0 0 0 0 0 

0,0489 4,89 5,66262 1,2387 2,3166 3,9874 0,003754 0,00351 0,003443 0,003569 

0,0978 9,78 11,32524 2,4835 4,6449 7,9953 0,007526 0,007038 0,006904 0,007156 

0,1467 14,67 16,98786 3,7344 6,9851 12,024 0,011316 0,010583 0,010383 0,010761 

0,1956 19,56 22,65048 4,9953 9,3449 16,087 0,015137 0,014159 0,013892 0,014396 

0,2445 24,45 28,3131 6,2876 11,764 20,252 0,019053 0,017824 0,017489 0,018122 

0,2934 29,34 33,97572 7,6166 14,243 24,521 0,023081 0,02158 0,021175 0,021945 

0,3423 34,23 39,63834 8,9508 16,752 28,843 0,027124 0,025382 0,024908 0,025804 

0,3912 39,12 45,30096 10,319 19,317 33,262 0,03127 0,029268 0,028724 0,029754 

0,4401 44,01 50,96358 11,707 21,921 37,749 0,035476 0,033214 0,032598 0,033763 

0,489 48,9 56,6262 13,136 24,604 42,375 0,039806 0,037279 0,036593 0,037893 

0,5379 53,79 62,28882 14,576 27,309 47,039 0,04417 0,041377 0,040621 0,042056 

0,5868 58,68 67,95144 16,043 30,067 51,795 0,048615 0,045556 0,044728 0,0463 

0,6357 63,57 73,61406 17,563 32,925 56,727 0,053221 0,049886 0,048987 0,050698 

0,6846 68,46 79,27668 19,124 35,863 61,796 0,057952 0,054338 0,053364 0,055218 

0,7335 73,35 84,9393 20,741 38,91 67,055 0,062852 0,058955 0,057906 0,059904 

0,7824 78,24 90,60192 22,431 42,096 72,557 0,067973 0,063782 0,062657 0,064804 

0,8313 83,13 96,26454 24,172 45,383 78,234 0,073248 0,068762 0,06756 0,069857 

0,8802 88,02 101,9272 25,952 48,745 84,043 0,078642 0,073856 0,072576 0,075025 

0,9291 92,91 107,5898 27,768 52,178 89,974 0,084145 0,079058 0,077698 0,0803 

0,978 97,8 113,2524 29,61 55,658 95,989 0,089727 0,08433 0,082892 0,08565 

1,0269 102,69 118,915 31,472 59,18 102,08 0,09537 0,089667 0,088152 0,091063 

1,0758 107,58 124,5776 33,338 62,709 108,18 0,101024 0,095014 0,09342 0,096486 

1,125 112,5 130,275 35,237 66,304 114,39 0,106779 0,100461 0,098782 0,102007 
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΢ύκθσλα κε ην απνηειέζκαηα ηνπ πεηξάκαηνο πνπ έγηλε ζην ANSYS βγήθαλ ηα 

αληίζηνηρα απνηειέζκαηα (TangMod=5.000): 

 

Βήκα 
Φνξηίν(ζε 

kN) 

Ρνπή 

Κάκςεο 

(kN.m) 

Μεηαηόπηζε (θαηά άμνλα -

y) Πεξηζηξνθή Μέζε ηηκή 

Πεξηζηξνθήο ΢εκείν 

1 

΢εκείν 

2 

΢εκείν 

3 

΢εκείν 

1 

΢εκείν 

2 

΢εκείν 

3 

0 0 0 0 0 0 0 0 0 0 

0,05 5 5,79 1,2663 2,3682 4,0763 0,003837 0,003588 0,00352 0,003649 

0,1 10 11,58 2,5414 4,7536 8,1825 0,007701 0,007202 0,007066 0,007323 

0,15 15 17,37 3,87 7,2403 12,464 0,011727 0,01097 0,010763 0,011154 

0,2 20 23,16 5,245 9,8167 16,901 0,015894 0,014874 0,014595 0,015121 

0,25 25 28,95 6,6794 12,508 21,54 0,020241 0,018952 0,018601 0,019264 

0,3 30 34,74 8,1673 15,304 26,361 0,024749 0,023188 0,022764 0,023567 

0,35 35 40,53 9,7327 18,249 31,439 0,029493 0,02765 0,027149 0,028097 

0,4 40 46,32 11,396 21,381 36,842 0,034533 0,032395 0,031815 0,032915 

0,45 45 52,11 13,164 24,715 42,597 0,039891 0,037447 0,036785 0,038041 

0,5 50 57,9 15,042 28,261 48,722 0,045582 0,04282 0,042074 0,043492 

0,55 55 63,69 17,012 31,984 55,154 0,051552 0,048461 0,047629 0,049214 

0,6 60 69,48 19,039 35,819 61,78 0,057694 0,054271 0,053351 0,055105 

0,65 65 75,27 21,129 39,774 68,614 0,064027 0,060264 0,059252 0,061181 

0,7 70 81,06 23,337 43,955 75,839 0,070718 0,066598 0,065491 0,067603 

0,75 75 86,85 25,781 48,595 83,865 0,078124 0,073629 0,072422 0,074725 

0,8 80 92,64 28,441 53,667 92,651 0,086185 0,081314 0,080009 0,082503 

 

 

 

§ 3.1.2 Δλαζηοπλαζηικό ςλικό με μικπέρ μεηακινήζειρ (όσι γευμεηπική μη-

γπαμμικόηηηα) 

 

 

΢ύκθσλα κε ην απνηειέζκαηα ηνπ πεηξάκαηνο πνπ έγηλε ζην ANSYS βγήθαλ ηα 

αληίζηνηρα απνηειέζκαηα (TangMod=5.000): 

 

Βήκα 
Φνξηίν(ζε 

kN) 

Ρνπή 

Κάκςεο 

(kN.m) 

Μεηαηόπηζε (θαηά άμνλα -

y) Πεξηζηξνθή Μέζε ηηκή 

Πεξηζηξνθήο ΢εκείν 

1 

΢εκείν 

2 

΢εκείν 

3 

΢εκείν 

1 

΢εκείν 

2 

΢εκείν 

3 

0 0 0 0 0 0 0 0 0 0 

0,0489 4,89 5,66262 1,2356 2,3106 3,9768 0,003744 0,003501 0,003434 0,00356 

0,0978 9,78 11,32524 2,4732 4,625 7,9605 0,007495 0,007008 0,006874 0,007125 

0,1467 14,67 16,98786 3,7538 7,0207 12,084 0,011375 0,010637 0,010435 0,010816 

0,1956 19,56 22,65048 5,0725 9,4895 16,334 0,015371 0,014378 0,014105 0,014618 

0,2445 24,45 28,3131 6,4416 12,056 20,755 0,01952 0,018267 0,017923 0,01857 

0,2934 29,34 33,97572 7,8567 14,711 25,33 0,023808 0,022289 0,021874 0,022657 

0,3423 34,23 39,63834 9,3356 17,487 30,112 0,02829 0,026495 0,026003 0,02693 

0,3912 39,12 45,30096 10,877 20,383 35,102 0,032961 0,030883 0,030313 0,031386 

0,4401 44,01 50,96358 12,488 23,413 40,325 0,037842 0,035474 0,034823 0,036047 

0,489 48,9 56,6262 14,181 26,598 45,816 0,042973 0,0403 0,039565 0,040946 

0,5379 53,79 62,28882 15,939 29,907 51,523 0,0483 0,045314 0,044493 0,046036 

0,5868 58,68 67,95144 17,749 33,317 57,403 0,053785 0,05048 0,049571 0,051279 

0,6357 63,57 73,61406 19,608 36,82 63,445 0,059418 0,055788 0,054788 0,056665 

0,6846 68,46 79,27668 21,518 40,418 69,651 0,065206 0,061239 0,060148 0,062198 
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0,7335 73,35 84,9393 23,487 44,127 76,046 0,071173 0,066859 0,06567 0,067901 

0,7824 78,24 90,60192 25,517 47,952 82,641 0,077324 0,072655 0,071365 0,073781 

0,8313 83,13 96,26454 27,654 51,978 89,581 0,0838 0,078755 0,077358 0,079971 

0,8802 88,02 101,9272 29,972 56,341 97,1 0,090824 0,085365 0,083851 0,08668 

0,9291 92,91 107,5898 32,482 61,067 105,24 0,09843 0,092526 0,090881 0,093946 

0,978 97,8 113,2524 35,25 66,279 114,22 0,106818 0,100423 0,098636 0,101959 

1,0269 102,69 118,915 38,26 71,951 124 0,115939 0,109017 0,107081 0,110679 

1,0758 107,58 124,5776 41,464 77,988 134,4 0,125648 0,118164 0,116062 0,119958 

1,125 112,5 130,275 44,843 84,351 145,36 0,135888 0,127805 0,125527 0,12974 

 

 

 

§ 3.1.3 Δλαζηικό ςλικό συπίρ πλαζηικέρ παπαμοπθώζειρ 

 

΢ύκθσλα κε ην απνηειέζκαηα ηνπ πεηξάκαηνο πνπ έγηλε ζην ANSYS βγήθαλ ηα 

αληίζηνηρα απνηειέζκαηα: 

 

Βήκα 
Φνξηίν(ζε 

kN) 

Ρνπή 

Κάκςεο 

(kN.m) 

Μεηαηόπηζε (θαηά άμνλα -

y) Πεξηζηξνθή Μέζε ηηκή 

Πεξηζηξνθήο ΢εκείν 

1 

΢εκείν 

2 

΢εκείν 

3 

΢εκείν 

1 

΢εκείν 

2 

΢εκείν 

3 

0 0 0 0 0 0 0 0 0 0 

0,0489 4,89 5,66262 1,2387 2,3166 3,9874 0,003754 0,00351 0,003443 0,003568996 

0,0978 9,78 11,32524 2,4835 4,6449 7,9953 0,007526 0,007038 0,006904 0,007155963 

0,1467 14,67 16,98786 3,7344 6,9851 12,024 0,011316 0,010583 0,010383 0,010761089 

0,1956 19,56 22,65048 4,9907 9,3357 16,071 0,015123 0,014145 0,013878 0,014382191 

0,2445 24,45 28,3131 6,2518 11,696 20,134 0,018945 0,017721 0,017387 0,018017645 

0,2934 29,34 33,97572 7,5172 14,064 24,211 0,022779 0,021309 0,020908 0,021665361 

0,3423 34,23 39,63834 8,7877 16,442 28,306 0,026629 0,024912 0,024444 0,025328461 

0,3912 39,12 45,30096 10,069 18,841 32,438 0,030512 0,028547 0,028012 0,029023727 

0,4401 44,01 50,96358 11,36 21,259 36,602 0,034424 0,032211 0,031608 0,032747598 

0,489 48,9 56,6262 12,675 23,72 40,842 0,038409 0,035939 0,035269 0,036539305 

0,5379 53,79 62,28882 14,005 26,211 45,132 0,042439 0,039714 0,038974 0,040375708 

0,5868 58,68 67,95144 15,337 28,706 49,428 0,046476 0,043494 0,042684 0,044217878 

0,6357 63,57 73,61406 16,67 31,201 53,725 0,050515 0,047274 0,046395 0,048061347 

0,6846 68,46 79,27668 18,011 33,714 58,054 0,054579 0,051082 0,050133 0,051931198 

0,7335 73,35 84,9393 19,369 36,259 62,44 0,058694 0,054938 0,053921 0,05585079 

0,7824 78,24 90,60192 20,731 38,811 66,836 0,062821 0,058805 0,057717 0,059780837 

0,8313 83,13 96,26454 22,095 41,367 71,241 0,066955 0,062677 0,061521 0,063717515 

0,8802 88,02 101,9272 23,475 43,953 75,698 0,071136 0,066595 0,06537 0,067700474 

0,9291 92,91 107,5898 24,865 46,56 80,192 0,075348 0,070545 0,06925 0,07171479 

0,978 97,8 113,2524 26,263 49,18 84,708 0,079585 0,074515 0,07315 0,075750086 

1,0269 102,69 118,915 27,668 51,815 89,25 0,083842 0,078508 0,077073 0,079807513 

1,0758 107,58 124,5776 29,084 54,469 93,827 0,088133 0,082529 0,081025 0,083895721 

1,125 112,5 130,275 30,515 57,154 98,456 0,09247 0,086597 0,085022 0,088029706 
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§ 3.2 Απεικόνιζη παπαμοπθυμένηρ διάηαξηρ  
 

§ 3.2.1 Δλαζηοπλαζηικό ςλικό με μεγάλερ μεηακινήζειρ (γευμεηπική μη-

γπαμμικόηηηα) 

 

Α) ΢ηελ εηθόλα 26 παξνπζηάδεηαη ε δηάηαμε όπσο απηή παξακνξθώζεθε θαηά ηε 

δηάξθεηα ηνπ πεηξάκαηνο. Οη δηάθνξεο ρξσκαηηθέο απνρξώζεηο παξνπζηάδνπλ ηηο δώλεο 

παξακόξθσζεο πάλσ ζηε δηάηαμε (TangMod=10.000): 

 

 

 
Δικόνα 26: Παξακόξθσζε δηάηαμεο (Μέγηζηε κεηαηόπηζε=148,278 mm) 

 

 

΢ηηο παξαθάησ εηθόλεο παξνπζηάδεηαη ε ειαζηηθή παξακόξθσζε θαηά Von Mises (Von 

Mises elastic strain) ζηα δηάθνξα θνκκάηηα ηεο δηάηαμεο καο. Δδώ αμίδεη λα ζεκεησζεί 

όηη ε ηζνδύλακε ηάζε Von Mises παξνπζηάδεη ππνινγηζηηθό ελδηαθέξνλ δηόηη έρνπκε 

κηα ηξηζδηάζηαηε δηάηαμε ζηελ νπνία αζθνύληαη νξζέο θαη δηαηκεηηθέο ηάζεηο θαη 

ζηνπο ηξεηο άμνλεο x,y,z.Ο ηύπνο ηεο ηζνδύλακεο ηάζεο Von Mises ζe παξνπζηάδεηαη 

παξαθάησ: 

 

 

ζe={ )](6)()()[(
2

1 222222

xzyzxyxzzyyx   }
1/2 
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Δικόνα 27: Κάζεηε δνθόο (Μέγηζηε θαηαπόλεζε=0,079706 , Διάρηζηε 

θαηαπόλεζε=0,11*10
-11 

Μέγηζηε κεηαηόπηζε=46,944) 

 

 
Δικόνα 28: Κάζεηε δνθόο (Μέγηζηε θαηαπόλεζε=0,079706 , Διάρηζηε 

θαηαπόλεζε=0,11*10
-11 

Μέγηζηε κεηαηόπηζε=46,944) 
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Δικόνα 29: Κάζεηε δνθόο (Μέγηζηε θαηαπόλεζε=0,079706 , Διάρηζηε 

θαηαπόλεζε=0,11*10
-11 

Μέγηζηε κεηαηόπηζε=46,944) 

 

 
Δικόνα 30: Κάζεηε δνθόο (Μέγηζηε θαηαπόλεζε=0,079706 , Διάρηζηε 

θαηαπόλεζε=0,11*10
-11 

Μέγηζηε κεηαηόπηζε=46,944) 
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Δικόνα 31: Κάζεηε δνθόο (Μέγηζηε θαηαπόλεζε=0,079706 , Διάρηζηε 

θαηαπόλεζε=0,11*10
-11 

Μέγηζηε κεηαηόπηζε=46,944) 

 

 
Δικόνα 32: Οξηδόληηα δνθόο (Μέγηζηε θαηαπόλεζε=0,078535 , Διάρηζηε 

θαηαπόλεζε=0,152*10
-7 

Μέγηζηε κεηαηόπηζε=152,131) 
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Δικόνα 33: Οξηδόληηα δνθόο (Μέγηζηε θαηαπόλεζε=0,078535 , Διάρηζηε 

θαηαπόλεζε=0,152*10
-7 

Μέγηζηε κεηαηόπηζε=152,131) 

 

 
Δικόνα 34: Οξηδόληηα δνθόο (Μέγηζηε θαηαπόλεζε=0,078535, Διάρηζηε 

θαηαπόλεζε=0,152*10
-7 

Μέγηζηε κεηαηόπηζε=152,131) 
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Δικόνα 35: Οξηδόληηα δνθόο (Μέγηζηε θαηαπόλεζε=0,078535 , Διάρηζηε 

θαηαπόλεζε=0,152*10
-7 

Μέγηζηε κεηαηόπηζε=152,131) 

 

 
Δικόνα 36: Οξηδόληηα δνθόο (Μέγηζηε θαηαπόλεζε=0,078535 , Διάρηζηε 

θαηαπόλεζε=0,152*10
-7 

Μέγηζηε κεηαηόπηζε=152,131) 
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Δικόνα 37: Οξηδόληηα δνθόο (Μέγηζηε θαηαπόλεζε=0,078535 , Διάρηζηε 

θαηαπόλεζε=0,152*10
-7 

Μέγηζηε κεηαηόπηζε=152,131) 

 

 

Δλδεηθηηθά παξνπζηάδνληαη παξαθάησ δύν από ηηο θνριηώζεηο όπσο απηέο 

παξακνξθώζεθαλ θαηά ηε δηάξθεηα ηεο αλάιπζεο: 
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Δικόνα 38: Κνριίαο 3 (Μέγηζηε θαηαπόλεζε=0,068745 , Διάρηζηε 

θαηαπόλεζε=0,151*10
-3 

Μέγηζηε κεηαηόπηζε=43,564) 

 

 
Δικόνα 39: Κνριίαο 4 (Μέγηζηε θαηαπόλεζε=0,038869 , Διάρηζηε 

θαηαπόλεζε=0,358*10
-4 

Μέγηζηε κεηαηόπηζε=37,444) 



 

 

38 

Αθόκα παξνπζηάδεηαη ζε εηθόλεο ε πιαζηηθή παξακόξθσζε ζε όζα ζεκεία 

παξαηεξήζεθε ην θαηλόκελν απηό. Έηζη ζηελ θάζεηε δνθό έρνπκε ηηο εηθόλεο 40,41,42: 

 

 
Δικόνα 40: Πιαζηηθή παξακόξθσζε θάζεηεο δνθνύ 

 

 
Δικόνα 41: Πιαζηηθή παξακόξθσζε θάζεηεο δνθνύ 
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Δικόνα 42: Πιαζηηθή παξακόξθσζε θάζεηεο δνθνύ 

 

Οκνίσο γηα ηελ νξηδόληηα δνθό θαη ηνπο θνριίεο (δίλεηαη ελδεηθηηθά έλαο): 

 

 
Δικόνα 43: Πιαζηηθή παξακόξθσζε νξηδόληηαο δνθνύ 
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Δικόνα 44: Πιαζηηθή παξακόξθσζε νξηδόληηαο δνθνύ 

 

 

 
Δικόνα 45: Πιαζηηθή παξακόξθσζε θνριία 1 
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Β) ΢ηελ εηθόλα 46 παξνπζηάδεηαη ε δηάηαμε όπσο απηή παξακνξθώζεθε θαηά ηε 

δηάξθεηα ηνπ πεηξάκαηνο. Οη δηάθνξεο ρξσκαηηθέο απνρξώζεηο παξνπζηάδνπλ ηηο δώλεο 

παξακόξθσζεο πάλσ ζηε δηάηαμε (TangMod=5.000): 

 

 

 
Δικόνα 46: Παξακόξθσζε δηάηαμεο (Μέγηζηε κεηαηόπηζε=119,938mm) 

 

 

 

΢ηηο παξαθάησ εηθόλεο παξνπζηάδεηαη ε ειαζηηθή παξακόξθσζε θαηά Von Mises (Von 

Mises elastic strain) ζηα δηάθνξα θνκκάηηα ηεο δηάηαμεο καο. Δδώ αμίδεη λα ζεκεησζεί 

όηη ε ηζνδύλακε ηάζε Von Mises παξνπζηάδεη ππνινγηζηηθό ελδηαθέξνλ δηόηη έρνπκε 

κηα ηξηζδηάζηαηε δηάηαμε ζηελ νπνία αζθνύληαη νξζέο θαη δηαηκεηηθέο ηάζεηο θαη 

ζηνπο ηξεηο άμνλεο x,y,z.Ο ηύπνο ηεο ηζνδύλακεο ηάζεο Von Mises ζe παξνπζηάδεηαη 

παξαθάησ: 

 

 

ζe={ )](6)()()[(
2

1 222222

xzyzxyxzzyyx   }
1/2 
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Δικόνα 47: Κάζεηε δνθόο (Μέγηζηε θαηαπόλεζε=0,034198 , Διάρηζηε 

θαηαπόλεζε=0,775*10
-12 

Μέγηζηε κεηαηόπηζε=35,286) 

 

 
Δικόνα 48: Κάζεηε δνθόο (Μέγηζηε θαηαπόλεζε=0,034198 , Διάρηζηε 

θαηαπόλεζε=0,775*10
-12 

Μέγηζηε κεηαηόπηζε=35,286) 
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Δικόνα 49: Κάζεηε δνθόο (Μέγηζηε θαηαπόλεζε=0,034198 , Διάρηζηε 

θαηαπόλεζε=0,775*10
-12 

Μέγηζηε κεηαηόπηζε=35,286) 

 

 
Δικόνα 50: Κάζεηε δνθόο (Μέγηζηε θαηαπόλεζε=0,034198 , Διάρηζηε 

θαηαπόλεζε=0,775*10
-12 

Μέγηζηε κεηαηόπηζε=35,286) 
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Δικόνα 51: Κάζεηε δνθόο (Μέγηζηε θαηαπόλεζε=0,034198 , Διάρηζηε 

θαηαπόλεζε=0,775*10
-12 

Μέγηζηε κεηαηόπηζε=35,286) 

 

 
Δικόνα 52: Οξηδόληηα δνθόο (Μέγηζηε θαηαπόλεζε=0,038762 , Διάρηζηε 

θαηαπόλεζε=0,767*10
-7 

Μέγηζηε κεηαηόπηζε=122,799) 
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Δικόνα 53: Οξηδόληηα δνθόο (Μέγηζηε θαηαπόλεζε=0,038762 , Διάρηζηε 

θαηαπόλεζε=0,767*10
-7 

Μέγηζηε κεηαηόπηζε=122,799) 

 

 
Δικόνα 54: Οξηδόληηα δνθόο (Μέγηζηε θαηαπόλεζε=0,038762 , Διάρηζηε 

θαηαπόλεζε=0,767*10
-7 

Μέγηζηε κεηαηόπηζε=122,799) 
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Δικόνα 55: Οξηδόληηα δνθόο (Μέγηζηε θαηαπόλεζε=0,038762 , Διάρηζηε 

θαηαπόλεζε=0,767*10
-7 

Μέγηζηε κεηαηόπηζε=122,799) 

 

 
Δικόνα 56: Οξηδόληηα δνθόο (Μέγηζηε θαηαπόλεζε=0,038762 , Διάρηζηε 

θαηαπόλεζε=0,767*10
-7 

Μέγηζηε κεηαηόπηζε=122,799) 
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Δικόνα 57: Οξηδόληηα δνθόο (Μέγηζηε θαηαπόλεζε=0,038762 , Διάρηζηε 

θαηαπόλεζε=0,767*10
-7 

Μέγηζηε κεηαηόπηζε=122,799) 

 

 

Δλδεηθηηθά παξνπζηάδνληαη παξαθάησ δύν από ηηο θνριηώζεηο όπσο απηέο 

παξακνξθώζεθαλ θαηά ηε δηάξθεηα ηεο αλάιπζεο: 
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Δικόνα 58: Κνριίαο 1 (Μέγηζηε θαηαπόλεζε=0,034581 , Διάρηζηε 

θαηαπόλεζε=0,121*10
-3 

Μέγηζηε κεηαηόπηζε=32,462) 

 

 
Δικόνα 59: Κνριίαο 2 (Μέγηζηε θαηαπόλεζε=0,028252 , Διάρηζηε 

θαηαπόλεζε=0,416*10
-4 

Μέγηζηε κεηαηόπηζε=27,746) 
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Αθόκα παξνπζηάδεηαη ζε εηθόλεο ε πιαζηηθή παξακόξθσζε ζε όζα ζεκεία 

παξαηεξήζεθε ην θαηλόκελν απηό. Έηζη ζηελ θάζεηε δνθό έρνπκε ηηο εηθόλεο 60,61,62: 

 

 
Δικόνα 60: Πιαζηηθή παξακόξθσζε θάζεηεο δνθνύ 

 

 
Δικόνα 61: Πιαζηηθή παξακόξθσζε θάζεηεο δνθνύ 
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Δικόνα 62: Πιαζηηθή παξακόξθσζε θάζεηεο δνθνύ 

 

Οκνίσο γηα ηελ νξηδόληηα δνθό θαη ηνπο θνριίεο (δίλεηαη ελδεηθηηθά έλαο): 

 

 
Δικόνα 63: Πιαζηηθή παξακόξθσζε νξηδόληηαο δνθνύ 
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Δικόνα 64: Πιαζηηθή παξακόξθσζε νξηδόληηαο δνθνύ 

 

 
Δικόνα 65: Πιαζηηθή παξακόξθσζε θνριία 1 
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§ 3.2.2 Δλαζηοπλαζηικό ςλικό με μικπέρ μεηακινήζειρ (όσι γευμεηπική μη-

γπαμμικόηηηα) 

 

΢ηελ εηθόλα 21 παξνπζηάδεηαη ε δηάηαμε ζε εηθόλεο όπσο απηή παξακνξθώζεθε θαηά 

ηε δηάξθεηα ηνπ πεηξάκαηνο. Οη δηάθνξεο ρξσκαηηθέο απνρξώζεηο παξνπζηάδνπλ ηηο 

δώλεο παξακόξθσζεο πάλσ ζηε δηάηαμε : 

 

 
Δικόνα 66: Παξακόξθσζε δηάηαμεο (Μέγηζηε κεηαηόπηζε=186,319 mm) 

 

 

΢ηηο παξαθάησ εηθόλεο παξνπζηάδεηαη ε ειαζηηθή παξακόξθσζε θαηά Von Mises (Von 

Mises elastic strain) ζηα δηάθνξα θνκκάηηα ηεο δηάηαμεο καο. Δδώ αμίδεη λα ζεκεησζεί 

όηη ε ηζνδύλακε ηάζε Von Mises παξνπζηάδεη ππνινγηζηηθό ελδηαθέξνλ δηόηη έρνπκε 

κηα ηξηζδηάζηαηε δηάηαμε ζηελ νπνία αζθνύληαη νξζέο θαη δηαηκεηηθέο ηάζεηο θαη 

ζηνπο ηξεηο άμνλεο x,y,z.Ο ηύπνο ηεο ηζνδύλακεο ηάζεο Von Mises ζe παξνπζηάδεηαη 

παξαθάησ: 

 

 

ζe={ )](6)()()[(
2

1 222222

xzyzxyxzzyyx   }
1/2
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Δικόνα 67: Κάζεηε δνθόο (Μέγηζηε θαηαπόλεζε=0,032435 , Διάρηζηε 

θαηαπόλεζε=0,106*10
-11 

Μέγηζηε κεηαηόπηζε=49,277) 

 

 
Δικόνα 68: Κάζεηε δνθόο (Μέγηζηε θαηαπόλεζε=0,032435 , Διάρηζηε 

θαηαπόλεζε=0,106*10
-11 

Μέγηζηε κεηαηόπηζε=49,277) 
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Δικόνα 69: Κάζεηε δνθόο (Μέγηζηε θαηαπόλεζε=0,032435 , Διάρηζηε 

θαηαπόλεζε=0,106*10
-11 

Μέγηζηε κεηαηόπηζε=49,277) 

 

 
Δικόνα 70: Κάζεηε δνθόο (Μέγηζηε θαηαπόλεζε=0,032435 , Διάρηζηε 

θαηαπόλεζε=0,106*10
-11 

Μέγηζηε κεηαηόπηζε=49,277) 
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Δικόνα 71: Κάζεηε δνθόο (Μέγηζηε θαηαπόλεζε=0,032435 , Διάρηζηε 

θαηαπόλεζε=0,106*10
-11 

Μέγηζηε κεηαηόπηζε=49,277) 

 

 
Δικόνα 72: Οξηδόληηα δνθόο (Μέγηζηε θαηαπόλεζε=0,038378 , Διάρηζηε 

θαηαπόλεζε=0,184*10
-07 

Μέγηζηε κεηαηόπηζε=191,477) 
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Δικόνα 73: Οξηδόληηα δνθόο (Μέγηζηε θαηαπόλεζε=0,038378 , Διάρηζηε 

θαηαπόλεζε=0,184*10
-07 

Μέγηζηε κεηαηόπηζε=191,477) 

 

 
Δικόνα 74: Οξηδόληηα δνθόο (Μέγηζηε θαηαπόλεζε=0,038378 , Διάρηζηε 

θαηαπόλεζε=0,184*10
-07 

Μέγηζηε κεηαηόπηζε=191,477) 
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Δικόνα 75: Οξηδόληηα δνθόο (Μέγηζηε θαηαπόλεζε=0,038378 , Διάρηζηε 

θαηαπόλεζε=0,184*10
-07 

Μέγηζηε κεηαηόπηζε=191,477) 

 

 
Δικόνα 76: Οξηδόληηα δνθόο (Μέγηζηε θαηαπόλεζε=0,038378 , Διάρηζηε 

θαηαπόλεζε=0,184*10
-07 

Μέγηζηε κεηαηόπηζε=191,477) 
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Δικόνα 77: Οξηδόληηα δνθόο (Μέγηζηε θαηαπόλεζε=0,038378 , Διάρηζηε 

θαηαπόλεζε=0,184*10
-07 

Μέγηζηε κεηαηόπηζε=191,477) 

 

 
Δικόνα 78: Κνριίαο 1 (Μέγηζηε θαηαπόλεζε=0,035129 , Διάρηζηε 

θαηαπόλεζε=0,120*10
-3 

Μέγηζηε κεηαηόπηζε= 43,852) 
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Δικόνα 79: Κνριίαο 1 (Μέγηζηε θαηαπόλεζε=0,035785 , Διάρηζηε 

θαηαπόλεζε=0,618*10
-4 

Μέγηζηε κεηαηόπηζε= 39,906) 

 

 

Αθόκα παξνπζηάδεηαη παξαθάησ ζε εηθόλεο ε πιαζηηθή παξακόξθσζε ζε όζα ζεκεία 

παξαηεξήζεθε ην θαηλόκελν απηό. Έηζη ζηελ θάζεηε δνθό έρνπκε ηηο εηθόλεο 80,81,82: 
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Δικόνα 80: Πιαζηηθή παξακόξθσζε θάζεηεο δνθνύ 

 

 
Δικόνα 81: Πιαζηηθή παξακόξθσζε θάζεηεο δνθνύ 
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Δικόνα 82: Πιαζηηθή παξακόξθσζε θάζεηεο δνθνύ 

 

Οκνίσο γηα ηελ νξηδόληηα δνθό θαη ηνπο θνριίεο (δίλεηαη ελδεηθηηθά έλαο): 

 

 
Δικόνα 83: Πιαζηηθή παξακόξθσζε νξηδόληηαο δνθνύ 
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Δικόνα 84: Πιαζηηθή παξακόξθσζε νξηδόληηαο δνθνύ 

 

 
Δικόνα 85: Πιαζηηθή παξακόξθσζε θνριία 1 
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§ 3.2.3 Δλαζηικό ςλικό συπίρ πλαζηικέρ παπαμοπθώζειρ 
 

 

΢ηελ εηθόλα 21 παξνπζηάδεηαη ε δηάηαμε ζε εηθόλεο όπσο απηή παξακνξθώζεθε θαηά 

ηε δηάξθεηα ηνπ πεηξάκαηνο. Οη δηάθνξεο ρξσκαηηθέο απνρξώζεηο παξνπζηάδνπλ ηηο 

δώλεο παξακόξθσζεο πάλσ ζηε δηάηαμε : 

 

 
Δικόνα 86: Παξακόξθσζε δηάηαμεο (Μέγηζηε κεηαηόπηζε=127,528 mm) 

 

 

 

΢ηηο παξαθάησ εηθόλεο παξνπζηάδεηαη ε ειαζηηθή παξακόξθσζε θαηά Von Mises (Von 

Mises elastic strain) ζηα δηάθνξα θνκκάηηα ηεο δηάηαμεο καο. Δδώ αμίδεη λα ζεκεησζεί 

όηη ε ηζνδύλακε ηάζε Von Mises παξνπζηάδεη ππνινγηζηηθό ελδηαθέξνλ δηόηη έρνπκε 

κηα ηξηζδηάζηαηε δηάηαμε ζηελ νπνία αζθνύληαη νξζέο θαη δηαηκεηηθέο ηάζεηο θαη 

ζηνπο ηξεηο άμνλεο x,y,z.Ο ηύπνο ηεο ηζνδύλακεο ηάζεο Von Mises ζe παξνπζηάδεηαη 

παξαθάησ: 

 

 

ζe={ )](6)()()[(
2

1 222222

xzyzxyxzzyyx   }
1/2

 



 

 

64 

 
Δικόνα 87: Κάζεηε δνθόο (Μέγηζηε θαηαπόλεζε=0,158135 , Διάρηζηε 

θαηαπόλεζε=0,109*10
-11 

Μέγηζηε κεηαηόπηζε=42,737) 

 

 
Δικόνα 88: Κάζεηε δνθόο (Μέγηζηε θαηαπόλεζε=0,158135 , Διάρηζηε 

θαηαπόλεζε=0,109*10
-11 

Μέγηζηε κεηαηόπηζε=42,737) 
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Δικόνα 89: Κάζεηε δνθόο (Μέγηζηε θαηαπόλεζε=0,158135 , Διάρηζηε 

θαηαπόλεζε=0,109*10
-11 

Μέγηζηε κεηαηόπηζε=42,737) 

 

 

Δικόνα 90: Κάζεηε δνθόο (Μέγηζηε θαηαπόλεζε=0,158135 , Διάρηζηε 

θαηαπόλεζε=0,109*10
-11 

Μέγηζηε κεηαηόπηζε=42,737) 
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Δικόνα 91: Κάζεηε δνθόο (Μέγηζηε θαηαπόλεζε=0,158135 , Διάρηζηε 

θαηαπόλεζε=0,109*10
-11 

Μέγηζηε κεηαηόπηζε=42,737) 

 

 

Δικόνα 92: Οξηδόληηα δνθόο (Μέγηζηε θαηαπόλεζε=0,160878 , Διάρηζηε 

θαηαπόλεζε=0,187*10
-6 

Μέγηζηε κεηαηόπηζε=131,653) 
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Δικόνα 93: Οξηδόληηα δνθόο (Μέγηζηε θαηαπόλεζε=0,160878 , Διάρηζηε 

θαηαπόλεζε=0,187*10
-6 

Μέγηζηε κεηαηόπηζε=131,653) 

 

 

Δικόνα 94: Οξηδόληηα δνθόο (Μέγηζηε θαηαπόλεζε=0,160878 , Διάρηζηε 

θαηαπόλεζε=0,187*10
-6 

Μέγηζηε κεηαηόπηζε=131,653) 
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Δικόνα 95: Οξηδόληηα δνθόο (Μέγηζηε θαηαπόλεζε=0,160878 , Διάρηζηε 

θαηαπόλεζε=0,187*10
-6 

Μέγηζηε κεηαηόπηζε=131,653) 

 

 

Δικόνα 96: Οξηδόληηα δνθόο (Μέγηζηε θαηαπόλεζε=0,160878 , Διάρηζηε 

θαηαπόλεζε=0,187*10
-6 

Μέγηζηε κεηαηόπηζε=131,653) 
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Δικόνα 97: Οξηδόληηα δνθόο (Μέγηζηε θαηαπόλεζε=0,160878 , Διάρηζηε 

θαηαπόλεζε=0,187*10
-6 

Μέγηζηε κεηαηόπηζε=131,653) 

 

 

 

 

Δλδεηθηηθά παξνπζηάδνληαη παξαθάησ δύν από ηηο θνριηώζεηο όπσο απηέο 

παξακνξθώζεθαλ θαηά ηε δηάξθεηα ηεο αλάιπζεο: 
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Δικόνα 98: Κνριίαο 1 (Μέγηζηε θαηαπόλεζε=0,078617 , Διάρηζηε 

θαηαπόλεζε=0,166*10
-3 

Μέγηζηε κεηαηόπηζε=40,097) 

 

 

Δικόνα 99: Κνριίαο 2 (Μέγηζηε θαηαπόλεζε=0,039781 , Διάρηζηε 

θαηαπόλεζε=0,630*10
-4 

Μέγηζηε κεηαηόπηζε=34,657) 
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ΚΔΦΑΛΑΙΟ 4 

 

ΑΠΟΣΔΛΔ΢ΜΑΣΑ ΑΝΑΛΤ΢Η΢ ΑΠΟ ΣΟ ΔΡΓΑ΢ΣΗΡΙΟ ΣΟΤ 

J.U.S.T. 
 

 

§ 4.1 Πίνακαρ αποηελεζμάηυν  
 

 

΢ην παλεπηζηήκην Jordan University of Science and Technology (Irbid,Jordan) ζην 

ηκήκα ησλ Πνιηηηθώλ Μεραληθώλ(Department of Civil Engineering) έγηλε αληίζηνηρν 

πείξακα ζε πξαγκαηηθέο ζπλζήθεο ππό ηελ επίβιεςε ηνπ αλαπιεξσηή θαζεγεηή 

Khaiderin M. Abdalla. Δθεί ε νκάδα ηνπ θ. Abdalla έβγαιε ηα παξαθάησ 

απνηειέζκαηα (ΣΔ΢Σ 5): 

 

Φορτίο(%) 
Φορτίο 
(ςε kN) 

Ροπή Κάμψησ 
(KN.m) 

Μετατόπιςη (ςε mm) Περιςτροφή  
Μέςη τιμή 

Περιςτροφήσ ΢ημείο 
1 

΢ημείο 
2 

΢ημείο 
3 ΢ημείο 1 ΢ημείο 2 ΢ημείο 3 

0 0 0 0 0 0 0 0 0 0 

4 10 11,58 2 2 3 0,0060606 0,0030303 0,002591 0,003893861 

8 20 23,16 4 3 4 0,0121212 0,0045455 0,003454 0,006706966 

12 30 34,74 7 9 13 0,0212121 0,0136364 0,011226 0,015358246 

16 40 46,32 8 12 17 0,0242424 0,0181818 0,01468 0,019034909 

20 50 57,9 9 14 24 0,0272727 0,0212121 0,020725 0,023070079 

24 60 69,48 10 21 33 0,030303 0,0318182 0,028497 0,030206207 

28 70 81,06 13 27 41 0,0393939 0,0409091 0,035406 0,038569634 

32 80 92,64 15 33 58 0,0454545 0,05 0,050086 0,048513634 

36 90 104,22 21 47 82 0,0636364 0,0712121 0,070812 0,06855341 

38 95 110,01 22 52 93 0,0666667 0,0787879 0,080311 0,075255142 

42 105 121,59 27 64 113 0,0818182 0,0969697 0,097582 0,092123306 

45 112,5 130,275 32 83 146 0,0969697 0,1257576 0,126079 0,116268907 

 

 

 

§ 4.2 Σο πείπαμα ηος πανεπιζηημίος ηος J.U.S.T. ζε εικόνερ 
 

 

Παξαθάησ παξνπζηάδνληαη κεξηθέο εηθόλεο από ην πείξακα πνπ έγηλε ζην εξγαζηήξην 

ηνπ παλεπηζηεκίνπ ζηελ Ινξδαλία: 
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Δικόνα 100: Δξγαζηεξηαθό πείξακα (Ιδηνθηεζία: J.U.S.T/ prof. K.M. Abdalla) 

 

 

 
Δικόνα 101: Δξγαζηεξηαθό πείξακα (Ιδηνθηεζία: J.U.S.T/ prof. K.M. Abdalla) 
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Δικόνα 102: Δξγαζηεξηαθό πείξακα (Ιδηνθηεζία: J.U.S.T/ prof. K.M. Abdalla) 

 

 

 
Δικόνα 103: Δξγαζηεξηαθό πείξακα (Ιδηνθηεζία: J.U.S.T/ prof. K.M. Abdalla) 
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Δικόνα 104: Δξγαζηεξηαθό πείξακα (Ιδηνθηεζία: J.U.S.T/ prof. K.M. Abdalla) 

 

 

 
Δικόνα 105: Δξγαζηεξηαθό πείξακα (Ιδηνθηεζία: J.U.S.T/ prof. K.M. Abdalla) 
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Δικόνα 106: Δξγαζηεξηαθό πείξακα (Ιδηνθηεζία: J.U.S.T/ prof. K.M. Abdalla) 
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ΚΔΦΑΛΑΙΟ 5 

 

΢ΤΓΚΡΙ΢Η ΑΠΟΣΔΛΔ΢ΜΑΣΩΝ 
 

 

§ 5.1 Γιαγπάμμαηα Μεηαηόπιζηρ - Φόπηιζηρ  
 

Αλαιύνληαο θαη ζπγθξίλνληαο ηα παξαπάλσ απνηειέζκαηα ησλ δύν πεηξακάησλ 

δηακνξθώλνπκε δηάθνξεο γξαθηθέο παξαζηάζεηο νη νπνίεο καο δίλνπλ κηα ζαθέζηεξε 

εηθόλα γηα ηα απνηειέζκαηα πνπ εμήρζεζαλ. 

Πην ζπγθεθξηκέλα ζηα παξαθάησ δηαγξάκκαηα βιέπνπκε πώο κεηαηνπίδνληαη ηα ηξία 

ζεκεία θαηά ηε δηάξθεηα ηεο θόξηηζεο ζπγθξίλνληαο ηα απνηειέζκαηα ηνπ 

παλεπηζηεκίνπ J.U.S.T. θαη ηνπ πεηξάκαηνο πνπ έγηλε ζην ANSYS: 

 

§ 5.1.1 Δλαζηοπλαζηικό ςλικό με μεγάλερ μεηακινήζειρ (γευμεηπική μη-

γπαμμικόηηηα) 

 

Γηα ηελ πεξίπησζε όπνπ TangMod=10.000 έρνπκε ηα δηαγξάκκαηα: 
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Γηα ηελ πεξίπησζε όπνπ TangMod=5.000 έρνπκε ηα δηαγξάκκαηα: 
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§ 5.1.2 Δλαζηοπλαζηικό ςλικό με μικπέρ μεηακινήζειρ (όσι γευμεηπική μη-

γπαμμικόηηηα) 

 

Γηα ηελ πεξίπησζε όπνπ TangMod=5.000 έρνπκε ηα δηαγξάκκαηα: 

 

 

 
 



 

 

79 

 
 

 

 
 

§ 5.1.3 Δλαζηικό ςλικό συπίρ πλαζηικέρ παπαμοπθώζειρ 
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§ 5.2 ΢ύγκπιζη Αποηελεζμάηυν 
 

΢ηα παξαθάησ δηαγξάκκαηα ζπγθξίλνπκε ηηο δηάθνξεο επηιύζεηο γηα ειαζηνπιαζηηθό 

πιηθό κε κεγάιεο κεηαθηλήζεηο ζε ζρέζε κε ηα δεδνκέλα ηνπ παλεπηζηεκίνπ ηεο 

Ινξδαλίαο: 
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Δπίζεο ζπγθξίλνπκε θαη ηηο επηιύζεηο ειαζηνπιαζηηθώλ πιηθώλ(TangMod=5.000) κε 

κεγάιεο θαη κηθξέο κεηαθηλήζεηο αληίζηνηρα ζε ζρέζε κε ηα δεδνκέλα ηνπ 

παλεπηζηεκίνπ ηεο Ινξδαλίαο: 
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§ 5.3 Δπεξήγηζη αποηελεζμάηυν 
 

Παίξλνληαο ζαλ πξώηε ηελ επίιπζε όπνπ έρνπκε ειαζηηθό πιηθό παξαηεξνύκε όηη ε 

γξαθηθή παξάζηαζε είλαη ζρεδόλ επζεία όπσο εμάιινπ αλακελόηαλ. Έηζη ζηελ 

επόκελε επίιπζε βάδνπκε θαη ζηνηρεία πιαζηηθόηεηαο ώζηε λα πξνζεγγίζνπκε 

θαιύηεξα ηελ θακπύιε ηνπ J.U.S.T. πάληα ππό ηελ παξάκεηξν κεγάισλ κεηαθηλήζεσλ. 

Η παξάκεηξνο πάλσ ζηελ νπνία βαζηδόκαζηε ώζηε λα πάξνπκε κηα πην ξεαιηζηηθή 

θακπύιε είλαη ε ηηκή ηεο εθαπηνκέλεο ηεο θακπύιεο ζηελ πιαζηηθή πεξηνρή (Tangent 

Modulus). Σν πιηθό έρεη πιαζηηθό κέηξν δπζθακςίαο πεξίπνπ ίζν κε 2.000. Η ηηκή 

όκσο απηή δεκηνπξγεί αξηζκεηηθά πξνβιήκαηα ζπγθιίζεσο ζην κνληέιν 

πεπεξαζκέλσλ ζηνηρείσλ πνπ ρξεζηκνπνηήζακε. Ξεθηλάκε ινηπόλ από ηελ ηηκή 10.000 

θαη παίξλνπκε κηα πξώηε πξνζέγγηζε. Σα απνηειέζκαηα καο αξρίδνπλ ζηγά ζηγά λα 

πξνζεγγίδνπλ ηα απνηειέζκαηα ηνπ J.U.S.T. θαη γη απηό μαλαιύλνπκε ην πξόβιεκα κε 

Tangent Modulus = 5.000. Δδώ όκσο ιόγσ ηεο παξακέηξνπ κεγάισλ κεηαθηλήζεσλ 

έρνπκε πξόβιεκα ζύγθιηζεο θαη ην πξόβιεκα θαηαθέξλεη λα επηιπζεί κόλν κέρξη ηα 

80kN (αληί ησλ 112,5kN). Δπαλαιάβακε ηηο επηιύζεηο θαη γηα ηελ πεξίπησζε κηθξώλ 

κεηαθηλήζεσλ, ρσξίο ηε γεσκεηξηθή κε γξακκηθόηεηα, κε ζηόρν λα δηεξεπλήζνπκε ηελ 

επίδξαζή ηεο ζηα απνηειέζκαηα. ΢εκεηώλνπκε ηέινο όηη ην κνληέιν πνπ 

ρξεζηκνπνηήζεθε δελ ιακβάλεη θαζόινπ ππόςε θαηλόκελα κνλόπιεπξεο επαθήο 

κεηαμύ ησλ δύν ηκεκάησλ ηεο ζύλδεζεο θαη ζπλεπώο δελ ππάξρεη ε δπλαηόηεηα 

κειέηεο ηεο επηξξνήο ηεο παξακόξθσζεο ησλ θνριηώλ ζηελ όιε απόθξηζε ηεο 

ζύλδεζεο. 

 

§ 5.4 ΢ςμπεπάζμαηα ανάλςζηρ 
 

΢ηελ αλάιπζε πνπ έγηλε ζε απηή ηελ εξγαζία πξνζεγγίζζεθε ε κεραληθή απόθξηζε 

θνριησηώλ ζπλδέζκσλ κεηαιιηθώλ θαηαζθεπώλ κε ειαζηνπιαζηηθή ζπκπεξηθνξά. 

Σέινο είλαη νπζηώδεο λα αλαθεξζεί πσο ην ζπγθεθξηκέλν κνληέιν ζα κπνξνύζε λα 

δώζεη αθξηβέζηεξα απνηειέζκαηα κε ηνπο αθόινπζνπο ηξόπνπο:  

 Γηαθξηηνπνηώληαο ηε δηάηαμε κε πεξηζζόηεξα θαη κηθξόηεξα πεπεξαζκέλα 

ζηνηρεία ηνπ ίδηνπ ηύπνπ (SOLID 187)  ή άιινπ παξαπιήζηνπ. 

 Δηζάγνληαο αθόκε πεξηζζόηεξα ζηνηρεία ζηηο παξακέηξνπο ηνπ πξνβιήκαηνο 

(πεξηζζόηεξν εμειηγκέλν θαηαζηαηηθό λόκν ηνπ πιηθνύ) αιιά θαη λέεο πην 

πνιύπινθεο κεζόδνπο γηα ηελ αθξηβέζηεξε επίιπζε ηνπ κε γξακκηθνύ 

πξνβιήκαηνο. 

 Λακβάλνληαο ππόςε ην θαηλόκελν ηεο απνθόιιεζεο κεηαμύ ησλ γεηηνληθώλ 

ηκεκάησλ ηεο ζύλδεζεο. 

Γπζηπρώο ν ππνινγηζηηθόο ρξόλνο θαη ζηηο δύν πεξηπηώζεηο είλαη απαγνξεπηηθά 

κεγάινο θαη μεθεύγεη αξθεηά από ηα πιαίζηα απηήο ηεο αλάιπζεο θαη ησλ κέζσλ πνπ 

είρακε γηα ηελ επίηεπμε απηήο.  
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